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摘要 

本研究主要是利用 3D 自製多功能行動光譜儀，優點是裝置輕便，具有觀察可見光光譜，

和螢光光譜的雙重功能，不僅如此，此裝置尚可利用卡榫概念擴充未來裝置，加強自動化的

可能性。 

透過此裝置檢測水果新鮮度和螢光性，並比對 HPLC 和質譜儀分析，實驗顯示（一）可

見光光譜有藍綠紅的基本頻譜，而螢光光譜則為藍綠頻譜（二）不同水果有不同的光譜特性

（三）每種水果的光譜強度會隨著天數改變，變動性為藍光>紅光>綠光，又以第一天到第三

天變化最大（四）蘋果無螢光性質，吸光度與濃度成正比，光譜變化穩定。這些現象顯示我

們的光譜儀確實可提供初步定性資訊，未來將更精進裝置，以便提供更多化學分子的訊息。 

壹、研究動機 

某天，我們在電腦教室查詢資料時，看到一則有關豬籠草螢光現象的報告，覺得很神奇，

因此對「螢光」這個主題產生了興趣，進而查閱有關「螢光棒」或「其他動植物的發光現象」

的相關資料和科展報告，最後選定水果當作我們的研究對象，藉此了解並驗證水果中是否有

螢光現象，並探討果汁的新鮮度，於是展開了光譜探究之旅。 

[相關教學單元]南一版本: 

二上：2-1 認識物質 2-2 水溶液 第四章光與色的世界  

二下：第一章化學反應 第五章有機化合物 

貳、研究目的 

一、自製可見光及螢光多功能行動光譜儀 

二、找出觀察光譜的最佳角度及光徑長 

三、果汁光譜實驗 

（一）探究在不同光源-裝置下的果汁光譜特性 

（二）觀察並比較果汁之可見光光譜和螢光光譜特性 

（三）探究果汁濃度與吸光度的關係 

（四）多重比對自製光譜儀、HPLC 和質譜儀在果汁新鮮度上的差異 

    參、研究設備及器材 

3D 列印機 一台 純水 約 4000c.c. 

黑色素料 —捲 硫酸奎寧 一小瓶 

美工刀刀片 12 小片 離心機 一台 

DVD 片 25 片 電源供應器 一台 

塑膠比色管(加蓋) 200 個 小試管(可塞進離心機中的) 100 多管 

石英比色管(加蓋) 三個 具有冷凍冷藏功能的冰箱 一台 

自製暗箱 一個 各種水果 依要求 

散熱片 四片 UVA385nm、365nm 共七個 

焊接工具(焊槍、焊錫) 三組 UVC275nm 五個 



 2 

肆、研究過程及方法 

[發想和探索] 

最初是根據第五十三屆科展作品的實驗方法來驗證水果是否

有螢光性，我們用紙箱自製暗箱（如圖 4-1），將果汁放在暗箱內，

用市售常見的紫外光筆直接照射果汁，觀察並拍照紀錄，經過數次

實驗討論後，老師發現我們的方法，表示看到的光有可能是反射光，

並不足以說明果汁是否有螢光，於是老師要我們查詢製作螢光光譜

儀的基本原理，並建議我們採用網路上的 3D「自製光譜儀」進行

實驗，之後依實驗條件進行多次的改良。 

目的一、自製可見光及螢光多功能行動光譜儀 

第一代：列印 Public lab 網站提供的螢光光譜儀 3D 模型，並以 DVD 做光柵。 

缺點：DVD 光柵不夠大，手機也不易固定。 

想法：根據螢光光譜儀製作原理的概念，將入射光與狹縫、光柵垂直為中心主軸設計光譜儀。 

 

第二代：使 用網站Tikercad繪製

3D 光譜儀設計圖，如圖 4-3 所示，並參考阿簡生物筆記提供的光柵角度資料，以綠光作為參

考，設計 42。光徑長 10cm 的透射光柵，加黑布以免外界影響。 

缺點：以此條件自製的光譜儀（如圖 4-4），並不能清楚地觀察到光譜。 

想法：為了釐清看不見光譜的問題，進一步探討光源、角度或路徑長可能造成的問題，因而

引發製作改變光柵角度和路徑長的想法，同時引進硫酸奎寧檢測螢光光譜的可能性。 

 

零件 
組合 

圖 4-2 第一代 

圖 4-4 第二代 

圖 4-1 紙暗箱 

圖 4-3 光譜儀 3D 部分設計圖 
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第三代：利用卡榫概念，設計可變更角度和光徑長零件，同時將燈源開三個洞，光源方向與

狹縫-光柵方向垂直者為螢光（兩個），平行者為可見光（一個），並因應 UV 燈變更固定方式。 

缺點：第三代自製光譜儀（如圖 4-6），無法固定拍攝用的手機，使得拍照因為位置差異，而

使光譜判斷誤差變大。 

第四代：仿照光源裝置，

透過卡楯概念加裝手機

固定架，解決拍攝控制變

因無法固定的問題，進而

得到第四代裝置，如圖

4-7 所示。  

圖 4-5 第三代 中間微調零件 第三代零件 

ＵＶ燈 

光柵 

ＵＶ燈 

ＬＥＤ燈 

比色管 

圖 4-6 構造圖 

俯視 

正視 

側視-手機 

側視-相機 
○5  ○6  ○7  

圖 4-7 第四代 

○1  ○4  ○3  ○2  

俯視 側視 正視 
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[改良結果]  

一、經過數次操作之後，將第二代的手機拍攝角度，由固定 42 度三角形變為可拆裝的 10 度

三角形，且每個三角形皆可將 DVD 光柵置入，藉此調整光柵角度和視角角度，同時也將光徑

長改為可組裝的零件，然後依實驗條件，改變角度和光徑長，以便找到最佳觀測角度和距離，

其結構如上頁圖 4-6 所示。 

註：光柵角度：光柵面與狹縫面的角度 

    視角角度：拍攝工具與狹縫面的角度 

    光徑長：狹縫面到拍攝處的距離，一節光徑長即為 2cm 

二、主要光源有手機 LED 可見光和 LEDUVA385nm 兩種： 

（一）可見光：依生活隨手可得的光源進行探究，將 LED 燈、日光燈(Hg)、太陽光(sun) 和鎢

絲燈(W)透過自製(DIY)和市售(scimage)的光譜儀，分析光譜圖所呈現的資訊如下： 

文獻皆建議以連續光譜來進行研究，為了確認差異性，於是進行四種燈源和兩種裝置，

觀察上圖，可知：不同燈源有不同的光譜圖，雖然連續光譜顏色比較豐富，然而將圖譜轉為

頻譜時，卻不易辨認特定波長的範圍，相較之下，不連續光譜雖然無法涵蓋全波，卻有明顯

的峰值，於是我們嘗試以 LED 作為燈源，設計光譜儀燈座，同時以日光燈作為波長校正參考

值。選擇手機 LED 當燈源，一則方便，二則是擔心一般手電筒因電池使用率而使亮度不同，

而影響光譜值的判讀。 



 5 

（二）原先有 365nm 和 275nm 光源，但 365nm 因操作不慎而燒壞，又 275nm 瓦數太低，不易

觀察，故本研究皆以 385nmUVA 連接電源供應器作為螢光的發射光源，其激發方式如圖 4-9。

 

目的二、找出觀察光譜最佳角度及光徑長 

實驗步驟： 
（一）將塑膠比色管內置空氣當對照組放入光譜儀中 

（二）依序每隔 10 度改變光柵角度、視角角度及路徑長來觀測光譜 

Ex：光柵角度 10 度、視角角度 10 度，測路徑長 2cm、4cm……10cm、 

    光柵角度 10 度、視角角度 20 度，測路徑長 2cm、4cm……10cm... 

（三）找出光譜位於中間、清晰明顯、沒有被切到的光譜訂為檢測光譜的最佳角度  

[實驗結果] 

不同光源有不同的觀測角度，實驗得知：紫外光的觀測角度大於可見光，詳細討論請參閱伍、

研究結果與討論。 
 

目的三、果汁光譜實驗 
（一）初階實驗： 

1. 準備好不同種待測水果 

2. 洗乾淨、削皮(若一般人吃水果時會「連皮吃」則不削)，不加水的條件下打成果汁/泥 

水果分三種： 

(1) 打成泥狀且可以直接通過濾網或濾紙 

(離心出來多無可測物，本實驗會盡量避免用到此種水果) 

(2) 橘子、柳丁和檸檬等果肉較軟、表皮較硬者，用擠壓式的取出果汁 

(因實驗過程中發現若直接打成果汁則會產生無法分離的雜質) 

(3) 可直接打成果汁並實驗 

3. 放進桌上型離心機中，運轉 15 分鐘後取出上層液體 

4. 分成三管並標示為室溫、冷藏、冷凍 

5. 將標示室溫的果汁比色管，放入設定好的光譜儀中，觀察並拍照可見光和螢光光譜圖，

並以第一天為標準值，其餘依此類推。 
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6. 利用 ImageJ 繪製螢光光譜及可見光光譜的波長與光譜值的關係圖，並分析比較差異性。 

註：室溫組一直放在室溫下，冷藏及冷凍皆置於冰箱，等到要檢測時再取出 

(每次測試間隔超過 12 小時、觀測期間為一個星期) 

ImageJ 軟體操作：下載並開啟 ImageJ  

（1） 點選 File->Open 開啟照片。 

（2） 點選 Image->Stacks->Images to 

Stack 將多張照片組成一圖檔。 

（3） 點選 Image->Transform 將圖片轉成

藍色靠左的方向。 

（4） 選定一框線，使其適用全照片全光譜

的範圍，方便作為分析。 

（5） 點選 Analyze->Plot Profile 畫出圖形。 

（6） 挑選藍光 436.6nm 和綠光 546.5nm

波鋒作為校正：點選Analyze->Tools->Curve Fitting，輸入：第一個波鋒像素-空格-436.6

換行輸入：第二個波鋒位置-空格-546.6，完成按 Fit 得到校正公式，如圖 4-10。 

（7） 點選左下方 List 並複製座標值，轉貼至 Excel，並帶入校正公式計算得波長。 

（8） 重複步驟 5 和 7 分析同一圖檔中所有照片。 

 

（二）進階實驗（驗證 DIY 光譜儀的可行性）： 

1. 先將水果打成汁，不過濾備用。 

2. 萃取：先取甲醇：甲酸=1:1，配製成 6%的萃取液，再依果汁：萃取液＝1:5 混合（混

合機混合均勻，超音波振盪 1min 使果汁中的物質溶於萃取液） 

3. 離心：以 4。C、5000rpm、30min 條件進行離心，取上清液，再以針筒抽取上清液，

打入 0.45pbdf 過濾。 

4. 取每種果汁過濾液 3ml 於自製光譜儀中觀察，每天觀察一次。其餘依序放入 HPLC

和質譜儀中觀察，並分析比較兩者差異性。 

圖 4-10 校正公式 
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伍、研究結果與討論 

目的一、自製可見光及螢光多功能行動光譜儀 

[結果與討論 1]從發想到自製光譜儀的過程中，最常遇到的問題是沒看到光譜，於是我們不得

不一一釐清問題的來源： 

（1） 光源強度：剛開始進行螢光實驗時，使用電池串聯到工作電壓，卻不見光譜，後來改用

電源供應器控制，才得以改善電流太小的問題。 

（2） 光源種類：原先想探討的是水果是否有螢光性，但因早期一直看不到光譜，於是想到用

可見光先檢測溶液，確認透射後是否能看見光譜，因此衍生出製作多功能光譜的概念。 

（3） 狹縫寬度：用美工刀片固定寬度，此一變因未造成困擾，所以沒有變動。 

（4） DVD 光柵角度和磨損程度：光柵角度會影響手機拍照位置，所以選定在照片中央處為佳，

還有，光柵會因摩擦而使光譜消失，所以製作幾次後，盡量不移動光柵。 

（5） 光徑長：資料顯示路徑長不可太短，以免影響分光效果，目前是選定看見三色光譜為主，

日後會考慮用反射方式，改善分光效果。 

（6） 比色管材質：塑膠材質是有機物質，可能會因吸收光而影響螢光光譜，故比較塑膠管和

石英管的差異，目前顯示兩者差不多，但因塑膠比色管較便宜，故採用。 

（7） 螢光材料：為了確認螢光的存在性，事先以螢光筆作為分析的參考對象，但因不知波長，

後採用硫酸奎寧作為校正和確認的螢光物質。 

（8） 環境干擾：在尋找光譜的過程中，常會發現環境光源也會產生光譜，為避免誤判，將四

周以黑布遮住，並設計密合性高的手機拍攝接環，一則固定手機，一則避免漏光。 

（9） 裝置穩定性：經過多次實驗，顯示光源、光柵、拍攝手機只要有微幅移動，就會造成光

譜偏移，使光譜模式改變，因此整個操作，除了放置比色管外，其餘盡可能維持不動。 

（10） 拍攝設定：原先以為顏色越多，越能分析差異性，設定 auto 拍攝時，顏色效果最明顯，

後來才知，auto 條件會改變，因此之後都改用手動，將拍攝條件固定。  

 

經過不斷的除錯後，終於製作出一個簡易，方便攜帶和檢測的多功能行動光譜儀（如圖 4-7）。 

目的二、找出觀察光譜最佳角度及光徑長 

[結果與討論 2] 為了確定手機拍攝的最佳狀態，於是我們分別進行了光柵角度、視角角度和

光徑長的改變，透過肉眼所觀察到的光譜，作為初步的篩選。詳細的變因分析，請看附件一，

此處僅列出一部分結果，作為說明： 

表 5-2-1   可見光譜—對照組水、光徑長 2cm 

光柵角度 10 20 30 40 50 60 

有較完

整的光

譜。 

視

角

角

度 

10 ---- ---- ----    

20 ----      

30       

40      × 

50     × × 

60    × × × 
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表 5-2-2   UVA 385nm 光譜—對照組硫酸奎寧、光徑長 2cm 

光柵角度 10 20 30 40 50 

除了某些

角度之外

的光譜皆

清晰完整。 

視

角

角

度 

10     ---- 

20     ---- 

30     ---- 

40     ---- 

50   ---- ---- × 

60   ---- × × 

（1） 可見光譜的角度太低或太高，都不利於觀察光譜，而螢光光譜則是太高不利於觀察。 

（2） 在可見光譜範圍裡，可看見藍綠紅三色的分佈，也可察覺明暗不同。 

（3） 在螢光光譜範圍裡，除了藍綠紅三色之外，還可看見紫色和靛色，紅色則相對不明顯，

還有，角度低容易曝光，此現象可由電流改變亮度。 

（4） 以可同時檢測螢光光譜及可見光譜的條件為前提，因此本研究使用光柵角度 30 度，視

角角度 30 度、光徑長 4cm，作為檢測的基本條件。 

目的三、果汁光譜實驗 

 [可見光光譜：不同光源-裝置中的光譜特性] 

[結果與討論 3]將果汁放在手機 LED 和日光燈照射下，透過自製光譜儀和市售光譜儀（scimage）

拍照所得光譜，截圖整理如表 5-3-1，以濃度 100%(原汁)和 20%的可見光光譜為例說明如下： 

（1） 五種水果中，蕃茄、檸檬、橘子和柳丁的光譜圖相似，而蘋果原汁不論在哪一種燈源-

裝置，只有綠、紅光譜，顯示蘋果原汁比其他果汁更會吸收藍光，已知蘋果原汁偏黃

褐色，其中黃色是紅光和綠光的混合，藍光被吸收，符合光學顏色理論。 

（2） 比對各種水果濃度，可明顯看到濃度越稀，光譜亮度越強。 

（3） 比對自製光譜儀和市售光譜儀呈現的光譜圖，雖然強弱有差異，但都有相似的型態，

顯示自製光譜儀可作為教具基本展示。 

[可見光光譜-濃度與吸光度]  

（4） 進一步將光譜圖依比爾定律 A=-log(It/I0)=klc 轉換成吸光度，先討論 LED-DIY 裝置，番

茄、檸檬、橘子、柳丁和蘋果在不同濃度下的吸光度如圖 5-3-1~5-3-5： 

表 5-3-1 果汁在不同燈源-裝置下的光譜圖 

水果種類 Tomato, lemon, tangerine, orange apple 

燈源-裝置 原汁-100% 20% 原汁-100% 20% 

LED-DIY     

LED-scimage 
    

Hg-DIY     

Hg-scimage 
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圖5-3-4 柳丁吸光度曲線圖(LED-DIY)
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由吸光度可知： 

1. 吸光度的變化值幾乎是： 

藍光>綠光>紅光。 

2. 番茄在藍光 400nm 和紅光 673nm 附

近的吸收度有相對極小值。 

3. 檸檬、橘子和柳丁的吸光度圖形相似，

查詢相關資料，可能是都是芸香科植

物，所以有相似的趨勢，與番茄和蘋

果的吸光圖明顯不同，可藉由吸光度

區分不同水果的特性。 

4. 蘋果在 433nm 和 485nm 有明顯的變

化，分析濃度和對應的數據的關係，可得圖 5-3-6，有漂亮的線性關係曲線圖，其

中 485nm 的誤差更小，符合比爾定律，可作為濃度與吸光度的示範教材。       

（5） 為了了解自製光譜儀和市售光譜儀的差異性，以同樣的方法，觀察果汁在 LED-scimage

裝置中的結果，如圖 5-4-1~圖 5-4-5，比較 LED-DIY 和 LED-scimage 吸光度圖，可發現： 
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1. 不論何種裝置，五種水果在光譜分佈上，大致雷同，可區分成三種類型。 

2. 芸香科的檸檬和柳丁相似度最高，其次是橘子。 

3. 番茄總是在高濃度表現不同，可能是濃度高的內容物會干擾光譜，使得光譜在高

濃度時，沒有穩定特徵。 

4. 不論何種裝置，蘋果在藍光區，隨著濃度增加，吸光度也增加。 

5. 除了蘋果之外，其他水果在 LED-DIY 和 LED-scimage 最明顯的不同點是：LED-DIY

的負值大部分落在 550nm~700nm（綠紅區間），而 LED-scimage 則落在 450nm~700nm

（藍綠紅），區間擴大很多。負值表示光經過果汁之後，亮度變強，而非減弱，這

可能是水果本身有螢光物質，經過 LED 激發後，產生螢光，因而使光強度變強，

water 

100% 

80% 

60% 

40% 

20% 

圖 5-4-7 檸檬光譜圖 
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此結果恰可與後續的螢光結果相呼應，放上檸檬光譜圖(圖 5-4-7)做為參考，可見濃

度越小，色光的範圍越大。 

6. 總結上述，自製光譜儀可提供初階的辨認、探討和分析。 

（6） 除了以 Hg-scimage 裝置校正光譜，同時觀察果汁的吸光度分佈，其結果如圖 5-5-1~5-5-5: 

1. 日光燈(Hg)與 LED 的吸光度分佈型態不同。 

2. 檸檬和柳丁在 LED-DIY、LED-scimage 和 Hg-scimage 的相似度很高。 

3. 不論哪個裝置，蘋果濃度和吸光度皆正相關，檸檬、柳丁在 Hg-scimage 最明顯，

番茄最無規律。 
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[可見光光譜-新鮮度]  

為了探討果汁新鮮度，先前做過一批以水為溶劑的果汁新鮮度實驗，因實驗裝置

控制變因還不穩，導致觀察結果沒有明確的規律性，後來有一筆經費，於是申請到公

共儀器中心進行 HPLC 和質譜儀實驗，為了能與精密儀器相比較，將實驗溶劑改為甲

酸＋甲醇，改由相機拍攝。先以番茄為例，圖 5-5-6 為番茄在不同天數的吸光度，範圍

是 350~650nm，圖 5-5-6-1 則將範圍縮小到 450nm~500nm，圖 5-5-6-2 則是 HPLC 分析在

400~500nm 的吸光度，比較兩者資料，顯示： 

(1) LED-DIY 變動較大的波長在 460~470nm，前三天吸收度忽大忽小，第三天

後呈現吸收變大的結果，此現象與 HPLC 的結果不同，HPLC 觀察到的吸

光度，在 450nm 隨著天數增加，吸光度會變小，第三天之後，變化則不大，

HPLC 紅光區也是相似的結果。 
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(2) 為了更清楚兩者間的差異，先觀察其他水果的光譜圖，然後列出變動性價

大的波段如下： 

圖 5-5-7-2 檸檬 HPLC 

400~500nm 吸光度 

圖 5-5-7-2 檸檬 HPLC 

400~500nm 吸光度 
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(3) HPLC 的吸光度都是隨著時間增加而減少，大部分的果汁從第一天到第二

天的變化最大，第三天之後差異漸小，顯示果汁第二天之後就已變質許多，

這驗證了市售宣導新鮮果汁要在短時間內飲用完畢的概念。 

(4) 蘋果如我們預期，第一天就已氧化差不多，所以差異最小。 

(5) 新鮮度實驗，觀察到檸檬與橘子相似，但柳丁則否，這與濃度實驗剛好相

反，這是一個有趣的現象，同樣是芸香科，表現相同特徵的變因竟然不同，

濃度是物理性，而氧化是化學性，顯示無法從單一變因簡單歸類。 

(6) 兩者儀器都有觀察到變異，但發生的時間點和波段不相同，以自製光譜儀

的觀察結果可知：除了蘋果之外，大部分的果汁變動性最大幾乎發生在第

二天到第三天，而 HPLC 則是第一天到第二天。分析其中原因，自製光譜

儀，是以日光燈手動校正，再加上光源並非平行光，使得波長校正並非真

的線性，因此設定的光譜波長與 HPLC 不見得相同，由圖 5-5-7-1~圖 5-5-10-1

可知，不同波段的變化趨勢可能相反，由此推論，自製光譜儀分析的範圍

與 HPLC 不同，因此這兩種儀器適合各自分析比較，但也可作為另一種數

據做為參考。 

(7) 水果一旦切開，就開始產生化學變化，除了 HPLC 觀察光譜圖之外，我們

也進行了質譜儀分析，其結果如圖 5-5-11~圖 5-5-15：圖中顏色分別表示：

黑色第一天，紅色第二天，綠色第三天，藍色第四天，黃色第五天。每種

果汁都三重複（同一顏色有三個點），根據實驗數據比對雲端資料，將物

質依照基本特性分類統計分析後，每種果汁在每一天的位置時間都不同，

而且都有明顯的差距，差距越大，表示不同性質的物質的可能性越大，觀

察黑色與紅色的差距，確實比其他天數的距離都大，與 HPLC 的結果相似，

此外，檸檬與橘子的型態也類似，加強新鮮度實驗中檸檬和橘子光譜雷同

的特性，可作為兩者同屬芸香科的間接證據。 

(8) 總結上述討論，雖然自製光譜儀尚不能精準到與 HPLC 和質譜儀相同，但

能給予初步的定性分析，可將此裝置發展成教具，讓同學從中實作 3D 列

印，透過角度和光徑長，了解物理性的光譜原理，透過比色管溶液實驗，

了解化學相關定律。 

 

圖 5-5-15 蘋果 圖 5-5-11 番茄 圖 5-5-12 檸檬 圖 5-5-13 柳丁 圖 5-5-14 橘子 
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[螢光光譜-頻譜模式] 

[結果與討論 4]圖 5-6 為 385nm UV 照射果汁和硫酸奎寧的結果，每種水果經 UV 照射後，顏

色並不相同。毫不意外，蘋果螢光特性不明顯，其餘水果都有不同程度的螢光，其中番茄呈

青色，與硫酸奎寧相似，奇異果則為紫紅色，橘子淡紫色，柳橙、葡萄和檸檬則呈藍紫色，

顏色雖不同，然而有螢光產生，意味著這些水果具有共軛雙鍵的化合物，例如芳香環化合物。 

透過自製的螢光光譜儀，將拍照所得螢光光譜，截圖整理如表 4-2，此表是濃度 80%各種

水果的螢光光譜（其他濃度請參見附件一），肉眼觀察光譜圖，發現： 

（1） 第一天室溫下的螢光光譜，與可見光光譜相比，只剩藍綠光，。 

（2） 從表 4-2 發現奇異果、柳橙和橘子第六天竟然還有光譜，這現象還有待釐清。大部分

水果隨著時間拉長，光譜變越暗，第七天幾乎全消失，此結果與可見光光譜一致，亦

即，不論是可見光光譜或螢光光譜，皆顯示水果放越久，越不新鮮，其光譜圖越暗，

意味著具有共軛雙鍵的化合物容易被氧化，而失去螢光特性。 

柳橙 奇異果 葡萄 橘子 番茄 檸檬 蘋果 

圖 5-6 各種 100%水果的 UV 照射圖 

硫酸奎寧 
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（3） 如圖 5-7 所示，依據分子能階與

躍遷原理，具有不飽和鍵者，如

π-π*鍵結的有機分子容易被

激發產生電子躍遷而產生較短

波長的螢光和較長波長的磷光，

本實驗觀察到光譜只有藍和綠，

依據電子躍遷的概念，且螢光屬

於激發光譜曲線的最高處，處於

激發態的分子最多，使得螢光強

度大於磷光，在圖 5-8~圖 5-12

具有此特徵，藉此推估藍光為螢

光，而綠光為磷光。 

 

水果螢光頻譜分析： 

4-1. 排除蘋果，在任何濃度之下，所有水果的

藍光強度都大於綠光。 

4-2. 蘋果的頻譜幾乎不受濃度影響。 

4-3. 觀察藍光強度，在 40%~80%濃度下，其強

度順序是檸檬>番茄 >奇異果>葡萄>柳橙

>橘子。其中檸檬特別顯眼，且濃度越大，

強度相對也越大。濃度太高太低，或許因

雜質或含有共軛鍵結數量不夠，使得排序不明顯。 

圖 5-7 發射螢光之電子躍遷概念圖 

（資料來源：宜蘭大學分子螢光分析法） 
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4-4. 觀察綠光強度，其變異比藍光大，沒有明顯的順序。當藍光大於綠光很多時，其光的顏

色都偏藍紫，如圖 5-6 中的葡萄、柳橙、和檸檬，然而當綠光漸多時，顏色漸變紫紅，

如奇異果，比例差不多則為青色，如番茄，因此透過顏色，我們可以初步推論藍綠光的

比例，進而判斷產生磷光的可能性。 

4-5. 由於濃度太高太低都沒有明顯規律，因此以 80%濃度作為後續螢光探討的控制變因。 

（二）探究儲存方式對果汁光譜的影響 

[結果與討論 5]為了更清楚判斷儲存方式對水果的影響，於是將譜圖進一步分析，分成可見光

（圖 5-13~圖 5-33）和螢光（圖 5-34~圖 5-54）兩部分，其結果如下： 

[可見光光譜-儲存方式變因] 
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（1） 觀察譜圖，發現所研究的水果，不論儲存方式為何，都會在三天之後的某一天出現

藍移現象（往藍光方向移動），如果是操作失誤，影響的應該是亮度大小，而不是波長，

因此我們初步判斷，水果在某一天有明顯的化學變化，使果汁內的成分改變，而影響光

譜波長的分佈，又為何只有一兩天，這是一個非常特別的現象，但礙於目前儀器和知識

不夠，無法明確分析，留待日後做更清楚的探討。 

（2） 前述肉眼可發現果汁放越久，光譜越暗，但以可見光光譜值來看，各色光的亮度忽

大忽小，與儲存方式沒有明顯規律可循，因此不易從頻譜觀察儲存方式對水果的明確影

響性。 

[螢光光譜-儲存方式變因]
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[結果與討論 6] 

（1） 可見光光譜有偏移現象，但螢光光譜則無，且多數水果放置越久，光譜值也變小，顯

示水果發生的化學反應，除了褐變氧化（紅移）和共軛雙鍵減少之外，尚有其他未知

的化學變化發生。 

（2） 番茄和蘋果相對其他水果而言，頻譜型態明顯不同。不論是濃度、儲存方式或各種光

譜都顯示蘋果氧化最明顯，與眾不同，從本實驗可明顯區分蘋果其他水果的不同。 

（3） 葡萄在藍光方面明顯大於綠光的現象，相較其他水果，顯示葡萄不易產生磷光。 

（4） 冷凍儲存的果汁，光譜值不見得小於室溫儲存，意味著不同水果冷凍儲存的保鮮程度

不同，有的加成，有的消減，而增減的原因最終還是與果汁內物質的變化有關，這都

有待進一步深入探討。 

陸、結論 

一、自製行動光譜儀可同時觀察可見光光譜和螢光光譜，透過卡榫概念，擴充未來裝置的方

便性和操作性，可提供多用途的檢測。 

二、自製光譜儀可調整角度、光徑長，變換光源及拍攝工具，實驗結果有明確的光譜圖譜，

適合延伸成教具，整合生活科技、物理和化學知識。 

三、透過自製多功能光譜儀觀察水果光譜特性，可得： 

（一） 可見光光譜最佳觀測角度和距離與螢光光譜不完全一樣。 

（二） 可見光光譜為藍綠黃紅模式，螢光光譜則只有藍綠模式。 

（三） 不同水果有不同的激發現象，可透過顏色和頻譜做初步判斷。 

（四） 水果切開後，一到兩天內物質就有明顯的變化。 

（五） 比對 HPLC 和質譜儀，顯示蘋果可作為自製光譜儀定性分析的素材。 

 

柒、未來展望 

經過多方嘗試，終於製作出一個簡易行動光譜儀，我們也試著用此裝置分析水果的新鮮

度和螢光性，發現還有許多問題待釐清，希望未來能將光譜儀的精細度提高，透過自製的行

動光譜儀看見光譜中隱藏的分子細節，提供一個快篩的檢測工具，為我們的食物（新鮮度、

酸度、甜度）或疾病（例如糖尿病糖度分析）達到有效率的辨別或採取預防措施。 
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https://goo.gl/Jc8sMj
https://goo.gl/URXKdy
https://goo.gl/efKnmo
http://www.tw-roc.org/Files/pdfs4web/ph7_1694.pdf
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玖、附錄 

附件一：可見光譜對照組空氣 
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附件二、可見光譜對照組水 
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附件三、UVA 光譜對照組硫酸奎寧 

 



作品海報 

【評語】032904  

研究內容為自製簡易行動光譜儀。針對果汁(蘋果、橘子、柳

橙、番茄、檸檬)，紀錄其在不同條件下(光源、濃度、放置天數)

的光譜特性，結果與 HPLC和質譜儀分析相比較。吸收程度與蘋果

汁濃度之關係符合比爾定律，可作為低成本的教具。惟所獲得光譜

數據與HPLC不符合，但可做定性推測，顯示自製儀器使用之限

制。 

E:\中小科展_58屆\排版\032904-評語 

 



	

	

	

	

	

	

	

	

	

	

	

	

	

	

	
	

	

	

	

	

	

	

	

	

	

	
 

3D列印機	 	一台	 純水	 	約4000c.c.	

黑色素料	 	—捲	 硫酸奎寧	 	一小瓶	

美工刀刀片	 	12小片	 離心機	 	一台	

DVD片	 	25片	 電源供應器	 	一台	

加蓋塑膠比色管	 	200個	 離心試管	 	100多管	

加蓋石英比色管	 	三個	 冰箱	 	一台	

自製暗箱	 	一個	 各種水果	 	依要求	

散熱片	 	四片	 UVA385/365nm	 	共七個	

焊接工具	 	三組	 UVC275nm	 	五個	

摘要	

本研究主要是利用3D列印機製作多功

能行動光譜儀，優點是CP值高，可調整，

靈活度高，裝置輕便，可觀察各種光源光

譜特性，還可以物理方法觀察化學變化，

而且，此裝置可利用卡榫概念擴充未來裝

置，加強自動化的可能性。	

依 此 裝 置 檢 測 水 果 新 鮮 度 和 螢 光 性，

並比對HPLC和質譜儀分析，實驗顯示:	

（一）可見光光譜有藍綠紅基本頻譜，而螢光

光譜則為藍綠頻譜。	

（二）不同水果有不同的光譜特性	

（三）每種水果的光譜強度會隨著天數改變，

變動性為藍光>紅光>綠光，又以第一

天到第三天變化最大。	

（四）蘋果無明顯螢光性質，吸光度與濃度成

正比，光譜變化穩定。	

這些現象顯示我們的光譜儀確實可提

供初步定性資訊，甚至可做為教學輔助工

具，幫助學生了解基礎科學。		

某天，我們在電腦教室查詢資料時，看

到一則有關豬籠草螢光現象的報告，覺得很

神奇，因此對「螢光」這個主題產生了興趣，

進而查閱有關「螢光棒」或「其他動植物的

發光現象」的相關資料和科展報告，最後選

定水果當作我們的研究對象，藉此了解並驗

證水果中是否有螢光現象，並探討果汁的新

鮮度，於是展開了光譜探究之旅。	

一、自製可見光及螢光多功能行動光譜儀	

二、找出觀察光譜的最佳角度及光徑長	

三、果汁光譜實驗	

（一）探究不同光源-裝置下的果汁光譜特性	

（二）比較果汁之可見光光譜和螢光光譜特性	

（三）探究果汁濃度與吸光度的關係	

（四）多重比對自製光譜儀、HPLC和質譜儀

在果汁新鮮度上的差異	

貳、研究目的	

壹、研究動機	

參、研究設備及器材	

肆、研究方法及流程	

以光譜觀測水果新鮮度和螢光性	

自製光譜儀	

以Public	lab網站的光譜儀
進行改良	

手機不
易固定	

新增卡榫	

DVD光柵
不夠大	

想法：以光柵垂直為中心
設計光譜儀	

以網站Tikercad繪
製3D光譜儀	

透射光柵	
42。(綠光)	

光徑長10cm	
加蓋黑布	

製作暗箱	

未使用	

引發目的二：找出最
佳觀測角度及光徑長	

可變更角度	

光柵角度
30°	

視角角度
30°	

可變更路徑	

光徑長
8cm	

同時以LED光譜
及UV光譜觀測	

可變更光源	

兩個垂直光
柵（螢光）	

一個平行光柵	

（可見光）	

[一、自製光譜儀流程圖]	 [二、果汁處理及光譜分析流程]	

水果實驗	

準備待測水果	

洗淨＆削皮	

打成泥狀直
接通過濾網	

離心後無可測
物，避免使用	

	果肉軟、表
皮硬者，擠
壓取出果汁	

橘子	

柳丁	

檸檬	

實驗發現若直接打
成果汁會產生無法

分離的雜質	

可直接打成
果汁並實驗	

放進離心機	

運轉15分鐘	

取上層液體	

室
溫	

冷
藏	

冷
凍	

放入光譜儀觀察並拍照	

ImageJ繪製譜圖	

}質譜儀	
HPLC


離心機	 UV燈和散熱片	

HPLC	硫酸奎寧	 3D列印機	



	
								
目的一、自製可見光及螢光多功能行動光譜儀	

	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
 

 
 
 
          
 
 
 
 
 
	
 	

										
 
 

伍、結果和討論	

看
不

到
光

譜



光源強度
 電池串聯
 工作電壓
 電源供應器


光源種類
 螢光(UV燈)
 可見光(手機燈)


狹縫寬度
 以刀片做狹縫


DVD光柵角度
 置於照片中央處


DVD磨損程度
 抽拔光柵的影響


光徑長
 長短因素


比色管
 塑膠比色管
 石英比色管


螢光材料
 螢光筆
 硫酸奎寧


環境干擾	 以黑布罩住


裝置穩定性


相機設定

俯視
 側視
 正視


[光譜儀演變]	

圖1	網路光譜儀	 圖2	固定式光譜儀	圖3	可調式光譜儀	

圖5	光譜儀操作圖	
圖4	影響光譜呈現的各種因素	

[光源探討]	
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LED-scimage	
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LED-DIY	
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Hg-DIY	
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W-DIY	

圖6	各種光源的光譜圖	

討論1：檢視看不見光譜問題的可能性，如圖4，並逐一修正，最後透過卡榫概念製作出圖3的光譜儀，此裝置

可改變角度，光徑長和各種光源因素，以便探討各種條件下的光譜。	

討論2：圖6比較自製（DIY）和	市（scimage）	
裝置在不同光源下所呈現的光譜型式，本研究
顯示連續光譜並未能提供明顯的光譜變化，因
此實驗皆以LED光源作為基本光源。


討論3：	
1.  角度太低或太高都不利於觀察可見光譜，太高不利於觀察螢光光譜。	
2.  在可見光譜範圍裡，有藍綠紅分佈，也可察覺明暗不同。	
3.  在螢光光譜範圍裡，除三原色之外，還有紫色和靛色，紅色較不明顯。	
4.  以同時可檢測螢光及可見光譜為前提，本研究使用光柵角度30度，視角角
度30度、光徑長4cm，作為檢測條件。	

討論4：	
1.  五種水果中，蕃茄、檸檬、橘子和柳丁的光譜圖相似，
而蘋果原汁不論在哪一種燈源-裝置，只有綠、紅光譜，
顯示蘋果原汁比其他果汁更會吸收藍光。	

2.  比對各種水果濃度，可明顯看到濃度越稀，光譜亮度越
強。	

3.  比對自製光譜儀和市售光譜儀呈現的光譜圖，雖然強弱
有差異，但都有相似的型態，顯示自製光譜儀可作為教
具基本展示。	

目的二、找出觀察光譜最佳角度及光徑長	

目的三、果汁光譜實驗	
[可見光光譜：不同光源-裝置中的光譜特性]		

[可見光光譜-濃度與吸光度]
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圖5-3-6		蘋果濃度與吸
光度的關係圖
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圖5-3-1	番茄吸光度曲線圖
(LED-DIY)
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圖5-3-2	檸檬吸光度曲線圖
(LED-DIY)


-0.2	
0	

0.2	
0.4	
0.6	
0.8	
1	

1.2	

350.0	 550.0	 750.0	

吸
光

度



波長（nm）


圖5-3-3	橘子吸光度曲線圖
(LED-DIY)
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圖5-3-4	柳丁吸光度曲線圖
(LED-DIY)
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圖5-3-5	蘋果吸光度曲線圖
(LED-DIY)
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圖5-4-1	番茄吸光度曲線圖	
(LED-scimage)


-0.6	
-0.4	
-0.2	

0	
0.2	
0.4	
0.6	
0.8	
1	

1.2	

350.0	 550.0	 750.0	

吸
光

度



波長（nm）


圖5-4-3	柳丁吸光度曲線圖
(LED-scimage)
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圖5-4-4	橘子吸光度曲線圖
(LED-scimage)
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圖5-4-5	蘋果吸光度曲線圖
(LED-scimage)
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圖5-4-2	檸檬吸光度曲線圖	
(LED-scimage)
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圖5-5-3	柳丁吸光度曲線圖
（Hg-scimage）
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圖5-5-2	檸檬吸光度曲線圖
（Hg-scimage）
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圖5-5-1	番茄吸光度曲線圖
（Hg-scimage）
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圖5-5-4	橘子吸光度曲線圖
（Hg-scimage）
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圖5-5-5	蘋果吸光度曲線圖
（Hg-scimage）
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伍、結果與討論（續）	

陸、結論	

一. 中華民國第	53	屆中小學科學展覽	
國小組化學科作品	蔬中求螢-蔬果
中螢光物質的探討與應用	

二. 中華民國第	47	屆中小學科學展覽	
國小組自然科作品	點亮黑夜的小精
靈---探究紅蘿蔔中的螢光		

三. 中華民國第	54	屆中小學科學展覽	
國中組生活與應用科作品	讓混油曝
光-自製光譜儀分析食用油光譜特性		

四. 中華民國第	57	屆中小學科學展覽	
國小組物理科作品	浮光掠「螢」-
探討螢光物質的發光特性		

五. 簡易摺紙光譜儀	游大立	科學教育
月刊	第	295	期	中華民國九十五年
十二月		

一. 自製行動光譜儀，價格低，可調整，好操作，
且可透過卡榫概念，擴充未來裝置的方便性
和靈活度，提供多用途的檢測。	

二. 透過自製多功能光譜儀觀察水果光譜特性，
可得：	

1.  可見光光譜最佳觀測角度和距離與螢光光譜
不完全一樣，且光譜分布也不同。	

2.  不同水果有不同的螢光現象，可透過顏色和
頻譜做初步判斷。	

3.  比對HPLC和質譜儀，水果切開後，一到兩
天內物質就有明顯的變化。	

三. 蘋果與其他水果的實驗光譜圖有明顯差異，
適合延伸成實驗教材教具，整合生活科技、
物理和化學知識。	

柒、參考資料	
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圖5-4-6	不同水果的吸光度圖
(LED-DIY)
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圖5-4-7	檸檬光譜圖

討論5：根據圖5-3-1~圖5-5-5可知	
1.  不論何種裝置，五種水果在光譜分佈上，大致雷同，
可區分成三種類型。	

2.  日光燈(Hg)與LED的吸光度分佈型態不同。	
3.  芸香科的檸檬和柳丁在LED-DIY、LED-scimage和
Hg-scimage	的相似度很高，其次是橘子。與番茄和
蘋果的吸光圖明顯不同，可藉由吸光度區分不同水
果的特性。	

4.  不論哪個裝置，蘋果濃度和吸光度皆正相關，檸檬、
柳丁在Hg-scimage最明顯，番茄最無規律。		

5.  蘋果在433nm和485nm有明顯的變化，分析濃度和對
應的數據的關係，可得圖5-3-6，有漂亮的線性關係
曲線圖，其中485nm的誤差更小，符合比爾定律，
可作為濃度與吸光度的示範教材。	

討論6：	
1.  番茄在高濃度時變異較大，可能是內容物
干擾光譜，使得光譜在高濃度時，沒有穩
定特徵。	

2.  以檸檬光譜圖(圖5-4-7)做為例，濃度越小，
藍光分散的範圍越大。	

[可見光光譜-新鮮度]	 第一天
 第二天
 第三天
 第四天
 第五天

DIY光譜儀


質譜儀

註一：天數顏色	{


註二：左下HPLC	
													右下質譜儀


討論7：根據圖5-5-6-1~圖5-5-10-1可知

1.  LED-DIY變動較大的波長在460~470nm，吸光度有如波動似的變化，HPLC和質譜儀分析則顯示第一天
到第二天變化最大，表示果汁第二天就變質許多，放越久吸光度會逐漸變小，第三天之後，變化則不
大。比對自製和HPLC的數據，結果並不相同。	

2.  實驗顯示蘋果第一天已氧化差不多，差異最小，符合蘋果易氧化的生活經驗。	
3.  新鮮度實驗顯示檸檬與橘子相似，濃度實驗則是檸檬和柳丁相似，同為芸香科，條件不同，表現不同。
可依此現象作為初步判斷芸香科與其他水果的特徵。	

4.  自製光譜儀尚不能精準到與HPLC和質譜儀相同，但可定性分析，將此裝置發展成教具，讓同學從中
實作3D列印，透過角度和光徑長，了解物理性的光譜原理，透過比色管溶液實驗，了解化學相關定律。		
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圖5-5-6-1	番茄不同天數吸光度(LED-DIY)
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圖5-5-7-1	檸檬濃度吸光度(LED-DIY)
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圖5-5-8-1	柳丁濃度吸光度(LED-DIY)
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圖5-5-9-1	橘子吸光度(LED-DIY)
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圖5-5-10-1	蘋果濃度吸光度(LED-DIY)


[螢光光譜-頻譜模式]		
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圖5-12 螢光室溫d1-20% 
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圖 5-10 螢光室溫d1-60% 
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圖5-11 螢光室溫d1-40% 
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圖5-8 螢光室溫d1-100% 
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圖5-9 螢光室溫d1-80% 

註三：水果對應顏色
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討論8：根據圖5-8~圖5-12可知

1.  排除蘋果，在任何濃度之下，所有水果的藍光強度都大於綠光，且蘋果的頻譜幾乎不受濃度影響。	
2.  觀察藍光強度，在40%~80%濃度下，其強度順序是檸檬>番茄	>奇異果>葡萄>柳橙>橘子。其中檸檬特別顯眼，
其濃度越大，強度相對也越大。	

3.  觀察照光後的柳橙、葡萄、和檸檬，顏色皆偏紫，奇異果偏紫紅，番茄為青色，透過混色概念，表示番茄綠光比
例較高，依電子躍遷理論，表示產生磷光的可能性比較高。		

圖5-7	發射螢光之電子躍遷概念圖	
（資料來源：宜蘭大學分子螢光分析法）	
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